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1.  Overview - Database

1. Overview - Database
When you acquire a large number of imageswith your software, it makes sense to
save them in a database. All of the file management functions, such as searching for
images, can bemore quickly and easily used in a database than with files that have
been saved separately.

Your software offers a Client/Server-database for this purposes that is based on the
Microsoft SQL technology. Your software's database doesn't only save images, it also
saves all other types of file, for example, text files, and results sheets.

Which software version supports which database?
Note: You can only use the database if you have purchased a special Database
Solution together with your software.

The following Database Solutions are available:

The SolutionDatabase Core Edition comprises the full database functionality. You
can create new databases and configure them to exactly suit your requirements. Make
use of the user management in order to assign access rights to individual users or to
user groups.

The SolutionDatabase Client Edition offers limited database functionality. You can
open existing databases, search for records and load them, or you can insert new
records. You cannot create a new database.

About the database manual
The documentation is for database users aswell as for database administrators. Since
database administrators havemore rights to work with the database, not all of the
topics covered in thismanual are equally relevant for all database users.

The topics about the user interface and the topics about working with the database are
for all database users. Therefore, it is assumed as a precondition that a database has
already been set up and configured.

The topics about configuring the database are only for the database administrator.
00061
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2. The user interface
2.1. Tool Window - Database

The database will be displayed in theDatabase tool window. This tool window
provides you with access to all of the records contained in the database, and to
numerous functions you can use to work with your database.

Views in the database window
TheDatabase tool window is divided into several areas. In each of these areas, a
special database view is displayed. You can adjust the size of these areas, in relation
to one another, however you want to. To do so, move your mouse pointer onto an
area's border in theDatabase tool window andmove it while keeping themouse
button depressed.

The illustration shows the schematic make-up of the Database tool window when you all available
views are displayed. the tool window will then contain the following database views.

(1) Tree View: The Tree View shows all of the data that is present in the database. In
this view you gain a quick overview of how the database is structured.

(2) Gallery View: In the Gallery View, you will see thumbnails of all of the documents
that are to be found under the selected record. You select the record in the Tree View
(1).
You can also have the documents shown in the form of a table. TheGallery View will
then be replaced by the Table View.

(3) Record Details View: In the Record Details View, you will see information about
the currently selected record.

(4) Search View: In the Search View, you select search definitions that have already
been saved and carry out the database search with them.

(5) Image Preview: The Image Preview is used to display the image that has currently
been selected in the database gallery (2).
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2.  The user interface

Toolbars in the database window
TheDatabase tool window contains two toolbars. These toolbars provide you with
access to themost important functionswhen you're working with a database.

Maximizing the database window
TheDatabasewindow can, as the only tool window, bemaximized. To do this, click
theMaximize button. You can find this button in the tool window's header. This will
make almost the whole of your software's user interface available for displaying the
database.

Commands in an empty database window
When no database has been opened, theDatabase tool window offers you the
commandswith which you can open a database, or set up a new database.
There, you can also find a list of the databases that were last opened. Simply click an
entry to open the corresponding database.

4915

2.2. Gallery View

In the Gallery View, you will see thumbnails of all of the images that are contained in
the database folder you have selected. Other documents (texts, MS-Excel sheets etc.)
will be displayed as an icon.

Where theGallery View will be displayed in the database window, depends on the size
of the database window.
When the database window has beenmaximized, you'll find the Gallery View in the
center of the tool window.When the database window is very small, the Gallery View
will be arranged below the Tree View.

Making the Gallery View appear/disappear
1. Click theOpenDatabase ViewsMenu button to open a list of all available

database views. You can find this button on theDatabase tool window's upper
toolbar.

2. Select theGallery/Table View entry.
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l When you do this, the Gallery View will either appear or disappear, depending
on whether it was already on display.

l Where theGallery View will appear in the database window, depends on the
size of the database window.

3. When, instead of the Gallery View, a tabular view appears in the database
window, click with your right mouse button in the background of the Table View,
then use theDisplayGallery command.

Setting the appearance of the Gallery View

Changing the size of thumbnails
You have the choice between two sizes of thumbnail. Right click in the background of
the Gallery View, and use theSmall Thumbnail Images command, to switch
backwards and forwards between the two thumbnail sizes. When you use a smaller
thumbnail size you will be able to load far more documents into the Gallery View.

Altering the thumbnails' labeling
You can set which database field is to be used for labeling the thumbnails. The record
name is, by default, used as labeling.

To do so, click your right mouse button in the Gallery View's background. From the
context menu, select theCustomize Views command. In theCustomize Views dialog
box, theGallery View entry will have already become active, and you can select
another database field for the labeling.

The definition of database views is user-dependent. That means that a college who
opens the same databasemaywell see other information.

Viewing information in the Gallery View

Which records will be displayed?
In the Gallery View, all of the records that are located within the database folder that
has been selected in the Tree View will be listed.

Which information will be displayed?
Select a document in the Gallery View.
The Record Details View then shows you numerous database fields together with
their field values, for the selected record.

Showing quick info on the documents
When youmove themouse pointer over a thumbnail, an info window will open, in
which you'll find information on this thumbnail. You can specify exactly which
information will be shown. To do so, use theCustomize Views dialog box, and select
the Tool Tip View entry in theView list.

Displaying a complete document path
Select a document and right click to open a context menu. Use theCopyHyperlink to
Clipboard command in the context menu.
This command copies the complete document path, including the record name, to the
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2.  The user interface

clipboard. Use the [Ctrl + V] shortcut to insert the document path into e.g., any text
document you want.

Working in the Gallery View
You can carry out a number of actions in the Gallery View.

Selecting records
In the Gallery View, you can select several records simultaneously. For the selection
the standardMS-Windows conventions for multiple selection are valid. With the
multiple selection you can, for example, with one command, load several images into
the document group, or move them to another database folder.

Should the records you want to select be contained in different database folders, first
define a database search that will include all of the records. For example, search for all
of the imageswhen you want to select specific images.When you carry out the
database search, the search results will automatically be displayed in the Gallery
View. Here, you can select the records you want.

Loading documents into the image preview
When you click once on an image in the Gallery View, the image will be loaded into the
Database tool window's Image Preview. The Image Preview providesmore space on
the screen for image display than theGallery View.
If you want to view an image inmore detail, load it into the document group.

Loading documents into the document group
If you want to load an image into the document group e.g., to measure it, or to have a
more detailed look at it, select the image, then use the Load Documents command in
the context menu.

Alternatively, you can also double click the required document to load it.

Changing the default settings for the loading of documents 
You can also alter the default setting that determines how a document reacts when
you double click it. To do this, use the Tools > Options command. Select theDatabase
> General entry. TheWhen a document record is double-clicked list contains a
number of ways in which a document is to behave when a double click is used.

Sorting records
In the Gallery View, you can sort records in a variety of ways. Use theSorting
command from theGallery View's context menu to open a list with various sorting
criteria.
For example, select theSort by Insertion Order sorting criterion. The last record in the
Gallery View is then the one that was last inserted.
Use theSorting > Sort Manually command tomove individual records byDrag&Drop,
within the Gallery View.

Opening the context menu
Select a record in the Gallery View and click with the right mouse button. In this way,
you open a context menu that offers you a number of commands you can, e.g., use for
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editing this record. Here you will also find general database commands and
commandswith which you can change the appearance of the database view.

00314

2.3. Tree View

The Tree View shows all of the records that are present in the database in a tree
structure. In this view you gain a quick overview of how the database is structured.

Making the Tree View appear/disappear
Click theOpenDatabase ViewsMenu button to open a list of all available database
views. You can find this button on theDatabase tool window's upper toolbar. Select
the Tree View entry.
When you do this, the Tree View will either appear or disappear, depending on
whether it was already on display.

Viewing information in the Tree View

Making information on documents appear
Select any record in the Tree View.
The Record Details View then shows you numerous database fields together with
their field values, for the selected record.

Showing quick info on the documents
When youmove your mouse pointer over an entry in the Tree View, an info window
will open, in which you'll find information on this record. You can specify exactly which
information will be shown. To do so, use theCustomize Views dialog box, and select
the Tool Tip View entry in theView list.

Displaying a complete document path
Select a document and right click to open a context menu. Use theCopyHyperlink to
Clipboard command in the context menu.
This command copies the complete document path, including the record name, to the
clipboard. Use the [Ctrl + V] shortcut to insert the document path into e.g., a text
document.
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2.  The user interface

Working in the Tree View
You can carry out a number of actions in the Tree View.

Browsing in the database
Double click on a database folder in the Tree View to expand the entry. Then all of the
records that lie under this folder will be shown.

As soon as you have selected a record in the Tree View, all of the records that lie one
hierarchy level below the selected record will be displayed in the Gallery View or the
Table View. Imageswill be shown as thumbnails, other documents will be shown as
icons.

Loading documents into the image preview
When you click once on an image in the Tree View, the image will be loaded into the
Database tool window's Image Preview. The Image Preview providesmore space on
the screen for image display.
If you want to view an image inmore detail, load it into the document group.

Loading documents into the document group
If you want to load an image into the document group e.g., to measure it, or to have a
more detailed look at it, select the image, then use the Load Documents command in
the context menu.

Changing the default settings for the loading of documents 
You can also alter the default setting that determines how a document reacts when
you double click it. To do this, use the Tools > Options command. Select theDatabase
> General entry. TheWhen a document record is double-clicked list contains a
number of ways in which a document is to behave when a double click is used.

Moving records
There are several ways of moving documents within the database. In the Tree View,
you canmove a document, e.g., an image, simply byDrag&Drop, into another
database folder. You can findmore information onmoving documents here.

Viewing search results
In the Tree View, you will also find the results of a database search. TheSearch
Results folder (2) is located on the same hierarchy level as the database (1).

When you expand theSearch Results folder, you will see all of the search definitions
and search templates (3) that have previously been set up for this database. An icon
shows you which is a search definition and which is a search template.

You can findmore information on searching in a database here.
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Opening the context menu
Select a record in the Tree View and click with the right mouse button. In this way, you
open a context menu that offers you a number of commands you can, e.g., use for
editing this record. Aswell as this, the context also contains general database
commands.

00307

2.4. Record Details View

In the Record Details View, you can for every record, view the way the database fields
have been filled out for this record.

Note: The Record Details View can't be displayed when the database window is very
small. Enlarge theDatabase tool window correspondingly. You will then find the view
either at the bottom left, or the bottom right, depending on how large the tool window
is.

Making the Record Details View appear/disappear
1. Click theOpenDatabase ViewsMenu button to open a list of all available

database views. You can find this button on theDatabase tool window's upper
toolbar.

2. Select theRecordsDetails View entry.
Should this command be displayed in gray, enlarge theDatabase tool window.
l When you do this, the Record Details View will either appear or disappear,
depending on whether it was already on display.

l Where the Record Details View will be displayed in the database window,
depends on the size of the database field.

Using the "Record Details" tool window.
For documents that you load into your software from the database, you can also use
theRecord Details tool window as an alternative to the Record Details View. In this
tool window, all of the information will be displayed, that is also displayed in the Record
Details View.
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2.  The user interface

In theRecord Details tool window, there is normallymuchmore room for the displayed
information, than in the database window.
In this case, you canmake the Record Details View disappear from the database
window, and also gainmore room for other views in theDatabase tool window.

Should theRecord Details tool window be hidden, use theView > ToolWindows >
Record Details command tomake it appear.

Customizing the appearance of the Record Details View
You can specify which database fields will be shown. To help you keep a better
overview, you also distribute the database fields over several different groups.
To do so, right click one of the database fields in the Record Details View. From the
context menu, select theCustomize Views command. In theCustomize Views dialog
box, all of the necessary entries are then already active, and you can select the
database fields you want.

The definition of database views is user-dependent. That means that a colleague who
opens the same database with his passwordmaywell see other information.

Viewing information in the Record Details View

Displaying and modifying field values
Select a record. You can select the record in the Tree View, Gallery View, or Table
View.
The Record Details View then shows you numerous database fields together with
their field values, for the selected record. Fields with a gray background serve only as
information. Fields with a white background can also be altered.

Please note that the database fields that are displayed depend on the type of record
selected.When you select a database folder you will see other database fields than
when you, for example, select an image.

Working in the Record Details View

Modifying field values
Use the Record Details View to edit existing entries in database fields. You can,
however, only change fields which have a white background (2). Fields with a gray
background (3) serve only as information.
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Confirming the changes
As soon as you have changed an entry in a database field, the two buttonsConfirm
Changes andAbort Changeswill become active in theRecord Details View toolbar
(1). Click theConfirmChanges button to have your changes adopted.

Expanding groups
To help you keep track of everything, you can assign the database fields to groups.
You can reduce every group in the Record Details View to its header. This enables
you to hide information that doesn't interest you. Double click on a group's header (4),
to reduce the size of the group, or to expand it again.

Opening context menus
TheRecord Details View offers you two different context menus.

Right click on a database field (5). This will open a context menu containing numerous
commandswith which you can e.g., change the appearance of the database view.

Right click on an entry in a database field (6). This will open a context menu containing
numerous commandswith which you can reformat the field entries.

00308

2.5. Search View

In the Search View, you select search definitions that have already been saved and
carry out the search with them.

Note: The Search View can't be displayed when the database window is very small.
Enlarge theDatabase tool window correspondingly, when you wish to have the
Search View displayed.

2.5.1. Making the Search View appear/disappear
Click theOpenDatabase ViewsMenu button to open a list of all available database
views. You can find this button on theDatabase tool window's upper toolbar. Select
Search View entry.
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2.  The user interface

2.5.2. Working in the Search View

(1) List of all saved search definitions
In the Search View, you can find a list with all of the search definitions that have been
defined for the active database to the left of theSearch button.
As soon as you have selected a search definition, the search conditions that have
been saved in it will be displayed in the Search View.

To define and to save search conditions as a file, use theDefine Search dialog box.

(2) Carrying out a search
Click theSearch button in the Search View to carry out the search.

The search results will be displayed in the Gallery View or in the Table View. Only the
records that fulfill the search conditions you've set will be displayed.When the ( 
[Organ] equals 'Liver' ) search condition has been selected, only the images of specific
samples, for example, will be displayed. Should a search not produce any records that
fulfill the search conditions set, the text There are no records to displaywill appear.

You will also find the results of a database search in the Tree View. There you will find
theSearch Results folder (2) on the same hierarchy level as the database (1). When
you expand theSearch Results folder, you will see all of the search definitions (3) that
have previously been set up for this database. An icon shows you which is a search
definition and which is a search template.

(3) Using search templates
When you define a search condition, you can either define a concrete value or leave
the value as a variable. Where a variable search condition is concerned, the user has
to add the concrete value for which the search is to be carried out, before the database
search can start.

A search condition with at least one variable search condition is called a search
template.

A completely defined search condition is, e.g., ([Organ] equals 'Liver' ). In this case you
are searching for all of the records in which, in the database field [Organ], the field
content 'Liver' has been entered.
A variable search condition is, e.g., ([Organ] equals '(variable)' ). Then, in the Search
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View, the database field [Organ] will appear as the search condition. Later in the
Search View, the user then specifies for precisely which organ is to be searched.

00315
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3.  Working with a database

3. Working with a database
3.1. Opening a database

When you want to work with a database, use theOpenDatabase dialog box. You
have to open the database when you want to load documents (e.g., images, charts or
workbooks) that are contained in that database, or to insert new records into it.
Only one database can be opened at a time. As soon as you open another database,
the one that has already been opened will be automatically closed.

To be able to open a database, youmust be registered as a user with the database
server. The database administrator takes care of that.

There are several ways in which you can open databases:

l Use theDatabase > Open command
l Use the File > Open > Database command.
l On theStandard toolbar, click the small arrow next to theOpen button to open a
context menu with all of the available commands you can use for loading files.

l You can find a list of the databases that were last opened, in theDatabasemenu.
Simply select one of the databases that is listed.

l When no database has been opened, in the emptyDatabase tool window, you'll
find a list of the databases that have recently been opened. Click the name of the
database you want, to open it.

Selecting a connection mode
When you want to open a database, you first have to register your PC with the
database server. The appearance of theOpenDatabase dialog box depends on the
connectionmode you have selected. Click theOptions button in theOpenDatabase
dialog box to select the connectionmode.

Entering connection data manually
Click theOptions button in theOpenDatabase dialog box.
If you want to enter all of the information that is necessary for logging-on to a server
manually, select theEnter connection datamanually option. Use this option when,
e.g., you only want to log onto a database on one occasion. To log-onmanually, you
require the following information: the databasemanagement system, the name of the
database, and the name of the server on which the database is located. If you are not
certain about anything, contact your database administrator.
Close theOptions dialog boxwithOK.

TheOpenDatabase dialog boxwill then contain theDatabase group.

Enter the name of the database in theDatabase > Database Name field. If a server
has already been selected, all of the databases that are on the selected database
server will be automatically listed.

In theDatabase > Server field, enter the name of the server on which the database
can be found. Should you not know the exact name of the server, click the [ ... ] button
to open theSelect Servers dialog box. Select the server from the list of the available
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database servers, then click theAdd >> button. Click theOK button to close the dialog
box, and to return to theOpenDatabase dialog box.

Select the databasemanagement system in theDatabase > Database system list.

Using the database connection file
Click theOptions button in theOpenDatabase dialog box.
If you want to adopt all of the information that is necessary for logging-on to a database
from a text file, select theUse database connection file option. That will save you a
great deal of writing.

Close theOptions dialog boxwithOK.
TheOpenDatabase dialog box now contains theDatabase connection file group.

Select the database connection file for the database you want to open, in the
Database connection file > File name list. By default, the database connection file that
was last selected will already have been preselected in the File name field.
Click the [ ... ] button if you want to open a database connection file that is not yet
present in the File name list.

You will see a description of the database you have selected in theDatabase
connection file > Description field. This short descriptionmust be entered by your
database administrator when the database connection file is set up. Should no short
description have been saved when the database connection file was set up, this field
will be empty.

User's details
With which authentication you need to log onto the database (either SQL or Windows
authentication) will have been determined when the database was set up.

Windows authentication
If you want to use the log-on data with which you are logged on to theMS-Windows
operating system also for logging-on to the database, select theWindows
Authentication entry in theUser > Authentication list. In this case, you will neither need
to enter a password nor a user name.

If the database requires theWindows authentication for the log on, you will have to be
registered with your company's LAN (Local Area Network).

SQL authentication
Select theSQLAuthentication entry in theUser > Authentication list if you want to use
database specific log-on data. In this case, you will have to enter both your password
and your user name every time you log on. You obtain your password and user name
from the database administrator.

Using a database as a standard database
To turn the current database into a standard database, select theUse as standard
database check box.
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3.  Working with a database

The standard database will normally be automatically opened when you start your
software. Use theOptions > Database > Standard Database dialog box if you want to
change the way the standard database behaveswhen your software starts.

The settings for the standard database are user dependent. For this reason, another
user can have defined another database as a standard database.

5621

3.2. Inserting data into a database
You can insert two different types of data into a database.

Structuring records
For the better structuring of a database, there are structuring record types, that are
indicated within the database by a folder icon. A record that belongs to this record type
isn't referenced to a document, but instead contains only the information that is
entered in the database fields. Use these records as a database folder. Create, e.g., a
structuring record "Experiment" with all of the information that describes the
experiment, then insert all of the images and reports that belong to this experiment,
underneath this record.

Documents
Documents are, for example, images, workbooks or diagrams.
You can of course insert all of the documents that you create with your software, or
load into it, into a database.

Aswell as that, you can, however, also insert any other files that have already been
saved on a datamedium. That applies also to document types that are not supported
by your software, e.g., MS-Word documents with the file extension DOC.

3.2.1. Overview - Inserting data into a database
There are several ways in which you can insert data into a database. Use the
commands in theDatabasemenu, or from various context menus, or click the buttons
in theDatabase tool window. You can also insert documents byDrag&Drop.
All of these possibilities will be described in the text that follows.

Menu commands
Use theDatabase > Insertmenu commands. The following commands are available:

l Geöffnete Dokumente einfügen
l Alle geöffneten Dokumente einfügen
l Dateien einfügen
l Strukturierenden Datensatz einfügen

Buttons
Use one of the buttons located on theDatabase tool window's upper toolbar.
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Context menu commands
Use the Insertmenu in the context menu. You open this context menu by right clicking
on one of the following views in theDatabase tool window.

l Strukturansicht
l Galerieansicht
l Tabellenansicht

You can also insert a single document, for example, an image, directly out of the
document group into the database. Right click the document's title in the document bar
to open a context menu. The context menu will contain the Insert into Database
command.

Drag&Drop
Select in MS-WindowsExplorer, the files that you want to insert.

Drag the selected files fromMS-WindowsExplorer either onto the database icon, or
onto another record in the Tree View. The files are inserted below the record.

You can also drag the files onto the database gallery or the Table View. To do so, first
select the record in the database, into which you want to insert the document. Then
drag the document fromMS-WindowsExplorer onto the database gallery or the Table
View.

Inserting images automatically into a database
You can have images automatically inserted into a database when they have been
acquired. You can findmore information on this topic here.

3.2.2. Notes on how to insert data into a database
When you insert records into a database, please pay attention to the points listed
below:

The database is structured hierarchically
You cannot insert records into every database level. When your database is based on
the database template provided, you won't be able to insert any data below images.
When you select an image, the data will be automatically inserted on the same
hierarchy level on which the image lies.

Inserting documents that have been changed
When you load a document from a database into your software, and edit it there, when
you close the document in your software, a dialog box containing numerous
possibilities, will open. You can replace the original document in the database, insert
the processed document as a new record, or save it as a file in any directory you want.

You can also change this behavior by altering the database's settings. Open the
Database > Settings > General > Other dialog box. Here, clear the Fields and records
> Allow replacing of documents check box.
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3.  Working with a database

Now, the documents in the database can't be overwritten. If you want to insert a new
version of a document into the database, you will have to insert the new document into
the database under a new name, then delete the old document.

Moving images to another database folder
Should you once have inserted documents in the wrong place, you can retroactively
move them to the correct database folder by using theCut andPaste context menu
commands.

00393 13102020

3.2.3. Inserting data into a database

Inserting documents into a database
You can insert all of the documents that you create with your software, or load into it
into a database. Aswell as that, you can also insert any other files that have already
been saved on a data storagemedium.
In these step-by-step instructions, you insert documents that have currently been
opened in your software.

1. Open the database with which you want to work.
2. Load documents that you want to insert into the current database, into your

software. You can also create new documents. It doesn't matter whether the
documents have already been saved as a file or not.
Switch to e.g., theAcquisition layout, and acquire an image, or load an image from
your hard disk.

3. First, select the record in the database into which you want to insert the document.
l Please note that you cannot insert documents at every hierarchical database
level.

l When your database is based on the database template provided, you won't be
able to insert any documents below images.When you select an image, the
documents will be automatically inserted on the same hierarchy level on which
the image lies.

4. Use theDatabase > Insert > Insert Open Documents command.
l The Insert Open Documents dialog box opens. This dialog box lists all
documents that have been opened. The icon in front of the document shows
you what type of document it is.

5. In the Insert Open Documents dialog box, you have to decide whether you want to
insert all of the opened documents into the database, or only some of them. Select
the check box in front of each of the documents you want to insert into the
database.

6. Click theOK button.
l The Insert <document type> dialog box opens for the first document you want
to insert. The dialog box's appearance depends on which type of document you
insert into the database.
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Enter all information into the insertion dialog that you want to have saved along with the record.

7. Checkwhether the document is going to be inserted into the correct record. In the
Insert into (1) group, the record into which the document is to be inserted will be
displayed.
Should you want to correct the higher level record, click theBrowse button.
l The Insert Into dialog box opens. TheDestination field gives you access to the
database's Tree View. Browse to the correct record, then confirm this withOK.

8. In thePermission Set (2) group, define whomay see the document. For example,
if you select theEveryone entry, you will allow every user who can log onto the
database to view the image.

9. Enter the required information on the document in the database fields. Database
fields that are displayed in bold lettersmust be filled out. In some database fields,
e.g., the one for the record name, you'll be supplied with suggestions.

Case 1: Inserting information for every single document
10. Click the Insert button to save the current document together with the information

displayed in the database.
l The Insert <document type> dialog box for the next document opens.

11. Fill out the Insert <document type> dialog box for all of the documents.

Case 2: Inserting the same information for all documents
10. If you want to insert the same information for all of the documents, click the Insert

All button.
l All of the documents that have been selected are saved in the database one
after the other. The Insert <Document Type> dialog boxwon't open again.

l The database fields are filled out in the sameway for all of the selected
documents. The information will be adopted from the first record.

When the documents have been inserted
l All of the documents that have been inserted have now been saved in the
database.

l The documents you have inserted will be displayed in the database window.
This process can, especially where large images are concerned, take some
time. The process is in progress as long as themouse pointer remains in the
form of an hourglass.
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l When an open document has been inserted into the database, it will still remain
open in the document group. Should you no longer need the image, close it
without saving it again.

l Should the inserted documents have already been saved as files: During the
insertion a copy of the file will be saved in the database. The files that have
already been saved won't be changed during the insertion in a database.

Inserting documents by Drag&Drop into a database
1. Load or create documents that you want to insert into the current database, in

your software.
2. Make theDatabase andDocuments tool windows appear. To do so, use theView

> ToolWindows command.
3. Position theDatabase andDocuments tool windows in such a way that both tool

windows can be seen in your user interface at the same time.

4. In theDocuments tool window, select the documents you want to insert into the
database.

5. Drag the selected documents from theDocuments tool window onto the folder in
the database window into which you want to insert them.
You can also drag the documents directly onto the database icon. In this case, the
documents will be inserted on the database's top hierarchy level.

By holding down the left mouse button, you can directly drag images which are loaded in your
software from the Gallery (1) tool window to the Database (2) tool window.

Note: You can also insert documents into a database from theGallery tool windows or
directly fromMS-WindowsExplorer using Drag&Drop.

Inserting new database folders
1. Make sure that in the tree view no record in theSearch Results database folder

has been selected, as otherwise the commandwill be inactive.
2. Click the Insert Record button. You can find this button on theDatabase tool

window's upper toolbar.
l Should several structuring record types have been defined in your database, a
selectionmenuwill open. It contains the structuring record types that have
been defined for this database.
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3. Select the Folder entry.
l The Insert Folder dialog box opens. The dialog box contains input fields for a
variety of database fields that relate to the database folder.

l The database fields that are to be filled out in the Insert Folder dialog box, have
been specified by the database's administrator.

l Some fields have to be filled out before you can set up the record. Those are
themandatory fields that are displayed in extra bold type. Other fields that
belong to this record can also be filled out or altered later on, in the Record
Details View.

l Depending on the type of information you have to enter, youmay be offered a
picklist, or a calendar field in which you can select a date.

4. Enter the name for the database folder in the Folder name field.
5. Fill out all input fields, then click the Insert button to set up the database folder.

l A new database folder will be set up. The database folder will be displayed in
the Tree View.

l Subsequently, insert the documents into this database folder.

Having images automatically inserted into a database when they
have been acquired

You can have images you have acquired with your software automatically inserted into
a database.

1. Open theAcquisition Settings dialog box.
To open this dialog box, click theAcquisition Settings button. You can find this
button, e.g., on theCamera Control toolbar.

2. Select theSaving entry in the tree structure.
3. Select the acquisition process for which you want to make the settings.

l Select, e.g., theSnapshot entry, when you want to have every image you
acquire, automatically saved in the database.

4. In theAutomatic save group, select the entryDatabase in theDestination list.
Now, the image will be automatically saved in a database when it has been
acquired.

5. In theDatabase > Name list, select the database in which you want the images to
be saved.
l You can either choose a specific database, or always have the image saved in
the database that is open when the acquisition ismade.

6. In theDatabase group, specify where the images are to be inserted in the
database, and who is allowed to view the images.

7. Close theAcquisition Settings dialog boxwithOK.
l From now on, all of the acquired individual imageswill be automatically saved
in a database.

00330 09012017
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3.3. Searching for records
You can search for data in your database at any time you want to. To do so, use the
Database > Define Search command or click theDefine Search button. You can
find this button on the top toolbar in the database window.

When you search through a database, please pay attention to the following points.

l The database search will always be conducted through the whole database.
l Youwill find the results of a database search in the Tree View. There, you will find
theSearch Results folder on the same hierarchy level as the database.

l You canmake use of the results of different database searches.

Different search possibilities
There are always two ways to search for records.

l Searching directly for a record
If you only need a search definition once, specify the search condition with the
Database > Define Search command and apply it directly.

l Searching in the Search View
If you want to use the same search definition repeatedly, save the search
definition and used these saved search definition in the Search View.

Before you start your search
Before you start a search it's advisable to update the view. By updating you will make
sure that all of the recordswill be found that at the time of the search are located in the
database. If you don't update the view, it can occur, that records that another user on
another PC, inserted into the database, shortly before the search began, won't be
found.
To update the view, use theDatabase > Views > Update Views command.

Searching directly for a record
1. Use theDatabase > Define Search command.

l TheDefine Search dialog box opens. You define the search conditions here.

2. In theSearch for group, you can limit the search to a few record types. You can,
e.g., only search for images.

3. Define one or more search conditions in theConditions group.
4. Click theSearch button to start the database search.

l TheDefine Search dialog box closes.

l In the Tree View, your software will automatically switch to theSearch Results
> Recent Search Results folder. The records that have been found will be
displayed in the Gallery or Table View.

l Should aRecent Search Results folder with the results of an earlier database
search already exist, the contents of this folder will be overwritten.
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Exiting the Search Results View
1. Select a record in the database gallery.
2. Click your right mouse button and select theGo ToRecord command in the

context menu.
l In the Tree View, your software will then automatically switch to the database
folder to which the selected record belongs.

Searching in the Search View
TheDatabase tool window is divided into several areas. In each of these areas, a
special database view is displayed. In the Search View you can select predefined
search definitionswith which you can carry out a database search.

In the step-by-step instructions that follow, it will be assumed that search definitions
that have been saved already exist.

1. Make sure that the Search View is on display.
To do so, click theOpenDatabase ViewsMenu button to open a list of all
available database views. You can find this button on theDatabase tool window's
upper toolbar. The icon in front of theSearch View command, must appear
clicked. You can recognize this status by the icon's background color.

2. Select the search definition you want from the list next to theSearch button.
l When you open a database that has been set up with the template, which is by
default provided, numerous predefined search definitionswill already be
available. For instance, select the search definition Find All Images to search
for all of the images contained in the database.

l In the Search View, the search conditionswill then appear.

3. Should the search definition you've chosen contain variable search conditions:
Make the necessary entries for the variable search conditions. These are, as a
rule, different for every database search.
l Theway you have tomake the entries can also vary. Youmay be offered a
picklist, or a calendar field will appear in which you can select a date. Should
you be searching for a note, youmay in certain cases have to enter the note
you're looking for (or a part of it) manually.

4. Click theSearch button.
l The search will be carried out. The records that have been found will be
displayed, e.g., in the database gallery.

Saving a search definition for the database search
1. Use theDatabase > Define Search command.

l TheDefine Search dialog box opens.

2. Specify in theSearch for group which type of record you want to look for.
For example, select only the Image check box to search it only for images.

3. Define the first search condition in the first line of theConditions group. Your
search condition can, in this case, also contain a variable value. To do so, select
the (Variable) entry from theValue list.
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l As soon as you have completely defined the first search condition, an additional
line appears for an additional search condition.

4. If necessary, define an additional search condition in the second line. In this case
you will have to specify the logical link between the two search conditions.
To do this, select one of the logical operators AND or OR in the line's first field.
l With the logical operator AND, both of the search conditionsmust be fulfilled
simultaneously, in order for a record to be found with this database search.
With the logical operator OR, only one of the two search conditions has to be
fulfilled in order for a record to be found.

5. Save the search definition. To do so, click theSave Search Definition button in
theDefine Search dialog box.
l TheSave Search Definition dialog box opens.

6. Give it a descriptive name, so that you and other users will be able to easily
recognize the search definition.

7. Close the open dialog boxes.
l For every search definition that has been saved, an individual entry will be
automatically set up in theSearch Results folder. In the Tree View, you will find
theSearch Results folder on the same hierarchy level as the database.

l The database search will be carried out and the records that have been found
will be displayed in the Gallery View.

l You can now select the search definition in the Search View.
00312

3.4. Loading documents from a database
There are several ways in which you can load data from a database into your
software:

l Use theDatabase > Load Documents command.
l Drag one or more documents, e.g., from theGallery View byDrag&Drop into the
document group.

l Double click on a document in the database to load the document into the
document group.
This behavior depends on the current settings in the Tools > Options > Database
> General dialog box.

Loading several documents from a database
This set of step-by-step instructions is only one example. There are several ways in
which you can load documents.
You will find notes on this, e.g., in the descriptions of the various database views.

1. Make sure that both the Tree View and theGallery View are on display.
2. In the Tree View, select the record that contains the documents you want to load.

l In the Gallery View, you will now see all of the documents that are to be found
under the selected record. Imageswill be shown as thumbnails, other
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document typeswill be shown as icons.
l You can also load documents which are the results of a search.When, for
example, you want to load all of the images that were acquired with a specific
microscope, define a search definition using thismicroscope's name. The
images found will be displayed in the Gallery View. There, you can select the
images you want.

3. Select the thumbnails or the icons for the required documents, in the Gallery View.
In the Gallery View, the standardMS-Windows conventions for Multiple Selection
are valid.

4. Click the Load Documents button. You can find this button on theDatabase tool
window's upper toolbar.
l When your software can open a document, it will be displayed in the document
group.

l If your software can't open the document, the appropriate application program
is opened and the selected document is loaded into this program.
Should the appropriate application program not have been installed on your
PC, you will receive amessage.

00313

3.5. Processing the documents from a database
Changing and adding to entries in database fields

When you set up a record, you already have tomake entries in themandatory fields.
You can supplement other entries later on.

1. Make sure that the Record Details View is on display.
Click theOpenDatabase ViewsMenu button to open a list of all available
database views. Select theRecordsDetails View entry.

2. In the Tree View, Table View or Gallery View, select the record to which you want
to add information or change the existing information.
l TheRecord Details View shows you the information that has already been
collected for this record. If all of the fields that you want to edit aren't shown
there, you can customize this view.

l In the Record Details View, mandatory fields will be displayed in extra bold
type. You can change the contents of these fields, but the fieldsmust not
remain empty. Fields whose content may not be changed (e.g., [Creation
Time]) will be displayed with a gray background.

3. Add to or change the entries relating to the record. Which fields you can edit, and
which you can't, depends on your database's structure.
l As soon as you have changed an entry in a database field, the two buttons in
the Record Details View's toolbarConfirmChanges andAbort Changeswill
become active.

4. Click theConfirmChanges button to have your changes adopted.
Click theAbort Changes button to abort the changes.
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l The record will be changed.

In any case, youmust click on one of the buttons to confirm or discard your selection,
since your software will wait for input here.

Processing the documents from a database
You can, at any time, load a document that has been saved in a database, then insert it
back into the database.

1. For example, load an image from a database. To do so, e.g., double click on its
thumbnail in the Gallery View.
l The image will now be shown in the document group.

2. Process the image in your software. Your software offers you numerous
possibilities for doing this. Here are a few examples:
l For example, use the commands in theProcessmenu to optimize the image
contrast.

l Use the buttons in theDrawing toolbar to label the image.

l Use the commands in theMeasuremenu tomeasure objects on the image.

3. When the processing is finished, close the image in the document group. To do
this, use e.g. the [Ctrl + W] shortcut.
l A dialog box offering several possibilities opens. You can replace the original
document in the database, insert the processed document as a new record, or
save it as a file in any directory you want.

4. From the dialog box's list, select, e.g., thePaste entry, then confirm this withOK.
l The altered document will then be inserted into the database, and will replace
the original document. When this is done, the original document will be
overwritten.

l The information from the database fields will be adopted from the original
document without any inquiry beingmade.

00065

3.6. Moving documents within a database
Moving documents within the database hierarchy

Should you have inadvertently inserted documents into a false database folder, you
canmove them from there to the correct folder.

Moving documents by using commands from the context menu
1. Select the documents you require in the Tree View, Table View or Gallery View.

l In the Gallery View, you can select several documents simultaneously. To do
so, keep the [Ctrl] key pressed while you select the documents.

2. Click the right mouse button to open a context menu. From the context menu,
select theCut command.
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3. Select the record into which you want to insert the document. You have to always
select the record that is located one hierarchy level higher.

4. Click the right mouse button to open a context menu. Select thePaste command
from the context menu.
l The document ismoved.

Moving documents by Drag&Drop
Alternatively, you can alsomove a document byDrag&Drop.

1. Select the documents you require, in the Tree View or in the Table View or Gallery
View.

2. While keeping your left mouse button depressed, drag the document onto the
record into which you want to insert it. You can also do this by dragging the
document from theGallery View to the Tree View.
l The document ismoved.

Moving documents into another document directory
At the end of the year, all of the records that were inserted into the database during the
year 2010, are to bemoved to a document directory of their own.

Defining a suitable search definition
1. Use theDatabase > Define Search command.

l TheDefine Search dialog box opens.

2. Click theSelect All button to find all of the records, irrespective of their record type.
3. Define the following search condition in theConditions group.

[Insertion date] >= '01.01.2010' AND [Insertion date] < '01.01.2011'
l Now, all of the records that were inserted into the database during the year
2010 will be found.

4. Save the search definition. To do so, click theSave Search Definition button in
theDefine Search dialog box.
l TheSave Search Definition dialog box opens.

5. Enter "2010" in theName field.
6. Close the open dialog boxes.

Selecting a search definition
7. Use theDatabase > Administration > Move Files command.

l TheMove Files dialog box opens.

8. Select the From saved query '2010' in the Files to bemoved' list.
l In theDescription field, you'll now see the search condition. Checkwhether the
search condition is correct.

Selecting a search definition
9. Click theSettings button.
10. Select theDocument Storage Type > File System entry in the tree view.
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11. Click theNew Volume button to integrate a new document directory into the
database.
l TheNew Volume dialog box opens.

12. Enter "2010" in theDescription field.
13. Set up the path name for the document directory.

When you do this, please note that the document directory has to be available to
all users when you want to continue to work with the database in the way you're
used to.

14. Select theArchive entry in theMedia Type list. By doing this, you indicate that the
new document directory "2010" has been finalized. No additional records can then
be inserted into this document directory anymore.

15. Close all open dialog boxeswithOK.
l Your software will thenmove all files belonging to the selected records, into the
document directory "2010".

l When themovement of these files has been successfully completed, a
message appears.

l Even when the records have beenmoved, you can still work with these records
as usual within the database. The prerequisite for this is, of course, that the
new document directory is available to all users.

l You can now, for example, copy this directory onto a DVD.
00090

3.7. Importing and exporting data
Exporting a database's structure

It canmake sense to export a database's structure in order to use the database export
file (DBE file) that has been created as a template for a new database that is to have
the same structure.

1. Open the database you want to export.
2. Use theDatabase > Import/Export > Export Database command.

l TheExport Database dialog box opens.

3. Assign the DBE file a name.
4. Specify the location at which the DBE file is to be saved.
5. In theOptions group, select which data are to be exported from the database.

Select, e.g., theExport structure only (database template) option when you want
to create a template for a new database.

6. Click theOK button to start the export.
l The Logging tool window will automatically appear. Here, you will see which
data are currently being exported.

l When the export has been completed, amessage boxwill appear. Additionally,
you'll see a corresponding notification at the end of the list.
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l With that, the export has been completed. You can then carry on working with
the current database as usual.

7. Use theDatabase > Import/Export > Import Database commandwhen you want
to set up a new database on the basis of the exported DBE file.

Importing data into a new database
You can import data from another database into your database. The prerequisite for
this is that both databases have the same database structure.

1. Use theDatabase > Import/Export > Import Database command.
l The dialog box opens.

2. Click theBrowse button and navigate to the directory in which the DBE file
(Database export file) is located.

3. Select the data you want to import.
l Select e.g., theExport structure, users, and structuring records option. Now,
the complete contents of the DBE file will be imported (that means, also
documents, should the DBE file contain documents).

4. Click theOK button to start the import.
l The Logging tool window will automatically appear. Here, you will see which
data are currently being imported. The importing process can, when
documents are also imported, take some time. Therefore, keep an eye on the
information in this tool window.When the importing process has been
completed, you will see a correspondingmessage at the end of the list.

l You can then begin to work with this database.

Exporting documents from a database
You can export individual documents from a database. In this way, you can, e.g., make
images available to users who have no access to the database.When you export a
document, youmake a copy of it. Thismeans that the original documents in the
database will be retained.

1. Select the records you want to export.
2. Use theDatabase > Import/Export > Export Documents command.

l TheExport Documents dialog box opens.

l It is essential that you keep an eye on the display at the bottom of the dialog
box. It shows you the amount of data that is going to be exported.

3. Make the required settings in this dialog box.
4. Select theReproduce database structure in file system check box tomaintain the

record's hierarchical structure. A directory will be set up on the hard disk for every
database folder in which there are files. This directory's name is also the name of
the record.

5. Click the [ ... ] button next to theDestination path field to choose the directory into
which the data you export is to be saved.

6. Click theOK button to start the export.
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l The export begins. The documents in the database will be retained.
00320
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4. Administrating the database
4.1. File storage in a database

When you set up a new database, you specify where the database files and the
images, (and other documents) are to be saved. The data can be distributed as shown
in the illustration.

(1) Database clients
The database clients are all PCs on which your software and an SQL client have been
installed. Your software offers (amongmany other functions), the user interface that
enables you to communicate with the database server.
For viewing or editing, the requested data will be transferred to the database client.
Thismakes it possible for numerous database clients to have access to the database
at the same time.

(2) Database server
On the database server, the databasemanagement system (DBMS) has been
installed.

On the database server lies, first and foremost, the actual database file. When you,
e.g., insert an image into the database, in doing so, you create a new record of the
"Image" type in the database. This new record will then be saved andmanaged in the
database. The database assigns this record an unambiguous name and saves all of
the corresponding information belonging to it (e.g., the insertion date, the file size or a
comment on the record). Themanagement of thesemetadata by the database
enables the user to search the database for records that meet the search criteria he
has specified.

Note: Images (or other documents) will not be saved within the database. Otherwise
the database file would becomemuch too large. The database file contains only the
reference to the place where the image has been saved.
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(3) File Server
The images and other documents are located in special file directories.

Please note: The PC onwhich a database's documents are locatedmust always be
accessible. Should this not be the case, you will receive an error message when you
try to load a document from the database.

The documents are usually located on a separate PC, the so called File Server. When
you connect with the File Server you can view the document directory in MS-Windows
Explorer.

You can also distribute your documents over different file servers. Use this possibility,
for example, to increase the speed of data transfer when users access the database
from different locations.

Use theSettings > Document Storage Type > File System dialog box tomanage your
database's document directories.

Please note: Always open all documents that have been saved in the database, via the
database, and not via theMS-WindowsExplorer! Also the deleting or renaming of
documents that are located in the document directorymust not be done viaMS-
WindowsExplorer, since in this case the database will not become aware of these
changes.

00328

4.2. Setting up a new database
Only the database administrator can set up a database.

Overview of the process flow when a database is set up
The following steps have to be taken when a new database is set up.

Setting up a new database

Defining record types

Defining the database structure

Setting up database fields

Setting up a new database
1. Select theDatabase > New command.

l TheNew Database dialog box opens. This dialog boxworks in a similar
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manner to a wizard. It guides you step-by-step through the setting up of a
database.

Step 1: Selecting the database server
2. Specify in theDatabase Server field, on which database server the database is to

be set up. If you have already set up a database on this server from your PC, you
will find the required server in the picklist.
l Alternatively, click the [ ... ] button. TheSelect Servers dialog box opens. Here,
select the server from theAvailable database servers list, then click theAdd >>
button. Click theOK button to close the dialog box, and to return to theNew
Database dialog box.

l On the database server, the database file is located. The documents e.g., the
images, can also be located on another PC, or even on several different PCs.

l You can findmore information on document storage in a database here.

3. In theUser Authentication group, you select the way you (and all future users) are
to log on to this database.
Select theWindowsAuthentication entry. WithWindowsAuthentication the data
with which the user logs on toMS-Windowswill also be used for logging on to the
database.
l Alternatively, you can also select theSQLAuthentication entry.
With the SQL Authentication the logging on data that have been defined for the
Microsoft SQL Server will be used. Every user of your databasemust know
these logging on data (they are supplied by the database administrator) and
has to enter them in theUser Name andPassword fields to be able to open the
database.

l The first step in setting up a database has now been completed.

4. Click theNext > button.

Step 2: Entering the name of the database, and specifying the storage
location for documents
5. Enter the name of the database in theDatabase Name field. The namemust not

be longer than 20 characters andmust not contain any spaces or special
characters. Under this name you'll find the database, in theOpenDatabase dialog
box.

6. If the new database is to become your standard database, select theUse as
standard database check box. This optionmakes sense when youmostly work
with the same database.
l Later on you can then use the Tools > Options > Database > Standard
database command to specify that the standard database will be automatically
opened whenever you start your software.

7. Enter the directory in which the documents are to be stored. To do so, click the [ ...
] button next to theDocument Storage Path field, then browse to the directory you
want to use.

Note: When several people are to work with the database, select a directory which is
also available to other users of this database.

- 35 -



4.  Administrating the database

If you're the only user of the database, you can also choose a local directory on your
own PC.

Note: To have your database with all of its documents regularly saved, make sure that
both the database server, and the PC onwhich the documents are stored, are
incorporated in an automatic data back-up process (e.g., every night).

8. When you work with several databases, enter a descriptive text for the new
database, in theDatabase Description field. This text will later be displayed in the
OpenDatabase dialog box (if you use theUse database connection file
connectionmode).

9. Click theNext > button.

Step 3: Selecting a database template
10. In the Template File Path field, choose a database template. A database template

has the file extension DBE.
A database template already contains a defined database structure. It may
possibly also contain documents that you can incorporate in your database as
well.
l Your software will have been supplied with a database template. During the
software installation, the template is installed in the following directory:
..\Documents and Settings\All Users\Application Data\Olympus\OSIS\ <Name
of your software>\Database\DBE

11. Select theCreate an empty database option, if you only want to adopt the
database structure from the database template.

12. You can set up your database on the basis of a template that was provided, then
modify the structure to suit your requirements.

13. Click theNext > button.
l Thewizard's next dialog box shows you all of the options that you have set up
for the new database.

Step 4: Checking the options for the new database
14. Check the options for the new database.

If you want to correct a setting, click the underlined terms. For example, click the
term "Database Name", if you want to change the name you've entered.
l Should you want to change an option, your software will jump back to theNew
Databasewizard's corresponding dialog box.

16. Click the Finish button to have the database set up.
l The Logging tool window will automatically appear. In it you can follow the
setting up of the new data.

l When a database is set up, a database export file (DBE file) will be
automatically created. You can use this DBE file as a template for your next
database.

l When a database is set up, a database connection file (DBC file) will be
automatically created too. The database connection file makes it possible for
you to quickly log on to this database in the future. You can find the DBC file in
the following directory:
...\Documents and Settings\All Users\Application Data\Olympus\OSIS\
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<Name of the software>
l The database will be set up and opened. You can see the database in the
Database tool window.

17. You now have to configure the new database.

Defining record types
The database is structured hierarchically. Structuring Records are records on the
highest hierarchy level, they are displayed in the structure view with a folder icon.
Structuring records aren't referenced to documents, they contain only the information
that has been entered in database fields.

When your database is based on the provided database template, it will contain just
one structured record type, with the name "Folder".

Example: You want to always assign the data in your database to a specific
experiment. Create the new record type, "Experiment".

1. Use theDatabase > Administration > Define Record Types command.
l When you define record types, you change the database structure. That is only
possible when the database has been opened in the exclusivemode.
When the database hasn't been opened in the exclusivemode, amessage
box, in which you can activate the exclusivemode, will open.

l To the left of theDefine Record Types dialog box, you can find a list of all
record types that have been defined in the current database.

l One or more field tables have been assigned to each record type. A field table
is a group of database fields that characterize the record type in detail.

Setting up a new record type.
2. Click theNew Record Type button.

l A new entry will be attached to the list of record types.

3. Enter the name of the new record type, in this example, "Experiment", and confirm
this with the [Enter] key.
l To the new record type "Experiment" the field tables, "Record Fields" and
"Folder Fields" will be automatically assigned.
The "Record Fields" field table contains general database fields, that are valid,
irregardless of the record type, for every record. To these records belong, the
record name, the setting up time (i.e. the time a record was inserted into the
database), and also a field for comments.

Defining database fields for the new database
4. Click the Fields button.

l TheDefine Fields dialog box lists, on the left, all of the field tables that have
been defined in the current database. You'll also find the new field table
"Experiment Fields" there.

5. Select the "Experiment Fields" field table.
l The "Experiment Fields" field table contains only one single database field, the
"Experiment Name" database field:
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6. Double click the "Experiment Name" database field. Set up all of the required
options for this database field, in theEdit Field dialog box. You can, e.g. define a
picklist.

7. Define additional database fields in the "Experiment Fields" field table, e.g.,
[Sample], [Client].
l You can find step-by-step instructions on how to define new fields here.

8. Close all open dialog boxes.

Assigning user groups
l TheAssign Configuration to Users dialog box opens.

9. Decide whether all of the database's users are going to be allowed to use the new
record.
Since in this case, every record is to be assigned to an experiment, select the user
Everyone then close the dialog boxwithOK.
l Your database now contains the structuring record type "Experiment".

l In theDatabase > Insertmenu, you'll now find theExperiment command. Use
this command to set up a new database folder for the data of an experiment.

Using a new record type
10. Use theDatabase > Insert > Experiment command

l The insertion dialog now contains all of the database fields that you have
defined for the "Experiment Fields" field table.

l As your next step, you should change the other database's views. To do so,
use theDatabase > Views > Customize Views command. Then specify for
each record type, and for each view, which fields are to be displayed.

l You can find a step-by-step instruction for doing this here.

Defining the database structure
When you define the database structure, you specify which data you can insert under
specific record types.

Example: Define a database structure with precisely two hierarchy levels. Prerequisite
for this is, that you have defined two structuring record types, e.g., "Project" (1) and
"Operator" (2). In this case, you can insert all of the data on a project into the project
folder. Each operator must, within the project folder,set up his own folder, into which
he inserts his project data.
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1. Open the database in the exclusivemode.
2. Use theDatabase > Administration > Define Database Structure command.

l TheDefine Database Structure dialog boxwill appear.
You alwaysmake the definition of the database structure in the right-hand half
of the dialog box. The left-hand side shows the current database structure, you
can't change anything there.

3. Specify for every record type, which record types are allowed to be underneath it.
First, select the Database entry from theRecord type list. This entry stands for the
topmost hierarchy level in every database.

4. In theAccept as child record list, select which records are allowed to be
underneath the topmost hierarchy level.
In this example, only the structuring record type "Project" is to be found
underneath the database icon (1).
To do this, select the check box in front of the record type "Project", and clear all of
the others.

5. Now select the next record type in theRecord type list. In this case, select the
record type "Project".
Then specify again in theAccept as child records group, which record type is
allowed to be underneath it, and clear all of the others. In this case, only the record
type "Operator" (2) is allowed.

6. Now select the next record type in theRecord type list. In this case, select the
record type "Operator".
In theAccept as child records group, select the check boxesChart, File, Image
andWorkbook, and clear all the others.
By doing this, you specify that documents can be inserted underneath a record of
the "Operator" record type.

7. Checkwhether the database hierarchy in the left-hand area of the dialog box is
correct.

8. Close theDefine Database Structure dialog boxwithOK.
l Youwill be asked if you want to leave the exclusivemode. You can answer this
question with yes, since the definition of the database has been completed.

9. Check the database structure. To do this, insert an example of each of the record
types you have defined into the database.
l When you are satisfied with the database structure, you can begin working with
this database. Alternatively, you can now, or at a later point in time, change the
database structure.

l Consider whether you want to export this database structure as a template, to
be able to use it again later on. To do so, use theDatabase > Import/Export >
Export Database command.

Setting up database fields
You can define which ever database fields you want that the database user can fill out,
or must fill out, when he sets up a record in the database.
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Example: You want to make it possible to enter the laboratory name aswell, when an
image is inserted. To do so, set up the database field [Laboratory No].

1. Open the database in the exclusivemode.
2. Use theDatabase > Administration > Define Fields command.

l TheDefine Fields dialog box opens. There, you will find all of the database
fields that are already defined in your database. Every database field it contains
is allocated to a group, and a group of database fields is called a "field table".

3. From the Field tables list, located in theDefine Fields dialog box, select the field
table to which, according to its contents, the new database field belongs. In this
example, you're only interested in images. Therefore, select the Image Fields
entry. When you want to enter the laboratory designation for all of the records,
you'll have to select theRecord Fields field table.
l In the Fields list, all of the database fields will then be listed that belong to the
Image Fields field table. This field table contains database fields that are
especially related to images.

4. Click theNew Field button. You'll find this button above the table with the
database fields.
l TheNew Field dialog box opens.

5. In theName field, enter a name for the new database field.
Enter, for example Laboratory No if you want the laboratory name to be entered
and saved for every image.

6. In theData type list, select the Text entry for the new database field.
7. Enter themaximumnumber of characters that can be used in the database field,

in theSize field.
For example, enter 10 when your laboratory name is to bemade up of amaximum
of ten characters.

8. In theDefault group, you determine how the field is to behave when a new record
is inserted.
For example, select the first option and leave the field empty to define no default
value. The database field will then be empty every time youmake an insertion,
and will have to be filled out.

9. Clear the Input required check box.
This will mean that the field can also remain empty when a record is inserted.
When you select this check box, no image can be inserted into the database,
unless the laboratory designation has been entered.

10. Select theEditable check box. Otherwise you will have to define a picklist.
11. Click theOK button to adopt your settings and to return to theDefine Fields dialog

box.
l The new database field will now be shown in the Fields list, under the Image
Fields field table's already defined database fields.

12. Close theDefine Fields dialog boxwithOK.
l Youwill then receive the query whether you want to make the changed
database views available to all of the database users, or not.
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13. Confirm themessage withYes.
l TheAssign Configuration to Users dialog box opens.
When all of the database's users are to be able to view the new database field
in the insertion dialog, select the check box in front of theEverybody entry, then
confirm this withOK.

14. Insert an image into the database.
l The new database field will appear in the Insertion dialog box.

l As your next step, you should change the other database's views. To do so,
use theDatabase > Views > Customize Views command. Then specify for
each record type, and for each view, whether the new database field is to be
displayed or not. You canmake the database field appear, e.g., in the Record
Details View, to be able to immediately see the operator for every record.

l You can find a step-by-step instruction for doing this here.
00097

4.3. Changing the database view
TheDatabase tool window is divided into several areas. In each of these areas, a
special database view is displayed. In the following, you can find a description of the
procedure for changing a database view.

When you change a database view, these settings are only valid for you.With other
users, the database viewswill not be changed.

Changing the database view
1. Use theDatabase > Views > Customize Views command.

l TheCustomize Views dialog box opens. A detailed explanation of this dialog
box can be found here.

2. Select the database view and the record type you want to change, in theSelection
of views and record types group.

3. Make the required changes. You have the possibilities that are given below. Not
every possibility is available for every database view.

l Adding additional database fields to the database view
l Hiding database fields that are present in a database view
l Changing the order in which the database fields are displayed
l Grouping database fields
l Deleting a group
l Changing the group's name

4. To adopt your changes, click theOK button.
l The changed database view will be displayed.
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Adding additional database fields to the database view
1. When theSelected fields list contains several groups: First, select the group to

which the database field is to be added.

l In the dialog box, a group is indicated by a directory icon (1).
In the example shown, two groups, each with three database fields, are on
display in the database view that has been chosen (2).

2. In theAvailable fields group, specify how the database fields are to be displayed in
theCustomize Views dialog box.
l If your database doesn't have toomany fields, click the Flat View button to
have all of the database fields listed, one under the other.

3. Select one or several database fields in theAvailable fields list. The standardMS-
Windows conventions for multiple selection apply.
l TheSelect >> button will become active.

4. Click theSelect >> button.
l The database fields you've selected are added to the bottom of theSelected
fields list.

5. Should you want to, you canmove the database fields you've added, by
Drag&Drop, to another position within the group.

Hiding database fields that are present in a database view
1. Select the database field in theSelected fields list.
2. Click the << Remove button.

l The database field will bemoved into theAvailable fields list. From then on, it
won't appear in the selected database view.

l The database field will only be removed from that view. The database field, and
all of the entries in this database field, will be retained.

Changing the order in which the database fields are displayed
1. Select the database field in theSelected fields list.
2. Click the buttonswith an arrow on it. With onemouse click you will move the

database field by one line upwards or downwards.
Alternatively, you can alsomove the database fields byDrag&Drop.
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Grouping database fields
You can decide whether all of the database fields that have been selected in a
database view for a certain record type, are to be displayed in one group, or in several
groups.

1. To group database fields, set up a number of folders in theSelected fields list. To
do this, click theNew Group button.
l The new group is set up in theSelected fields list. You can enter the name
directly when you set it up. However, you can change it later whenever you
want to.

2. Move the required database fields into the new group byDrag&Drop.
3. Should you want to add database fields that have not yet been displayed to the

group, select them in theAvailable fields list, then click theSelect button.
4. Close theCustomize Views dialog boxwithOK.

l When several groups have been defined, you can, for example, minimize one
group, and in this way gainmore room on your screen. Distributing the
database fields over several groups is especially advantageouswhere images
are concerned, since there, a very large number of database fieldsmay be
displayed.

Deleting a group
1. Should there be database fields in the group that is to be deleted, that you want to

continue to display, simplymove them byDrag&Drop into another group first.
2. Then select the group, and click theDelete Group button.

l All of the database fields belonging to the deleted group will bemoved back into
theAvailable fields list.

3. Close theCustomize Views dialog boxwithOK.

Changing the group's name
1. To do this, click once on the group to select it.

l The group's namewill then be highlighted in blue.

2. Click on the group oncemore.
l Now, the namewill be editable. You will recognize this by the black frame
around the group's name and by the form of the cursor.

3. Enter the new name, then press the [Enter] key.
l The new namewill be displayed.

00319

4.4. Managing user rights
When you set up a new user for a database, you can assign him one or more roles.
When the user hasmore than one role, either one role will be assigned as default role,
or, whenever he logs on to the database, he will be asked which role he wants to use.
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The role he chooses determineswhich rights the user has to view or change data in
the database. The functions that are linked to each role are predefined and cannot be
changed.

Which roles are there?

Guest
Guests can read the records that have been assigned to theEveryone group. They
can neither change the database nor manage user rights.

User
Users can by default read and update their own group's records, insert new records
into this group, and delete records. They aren't allowed to view or change any other
records. They can neither change the database structure nor manage user rights.

Power User
Power Users are allowed to do everything that users are allowed to do. Additionally
they are allowed to change the database structure. However, as Power User they
can't change user rights. Themoving of records is also only possible as database
administrator.

Administrator
Administrators have full access to the database. Aswell as that, they are allowed to
manage the database's user rights.

The administrator for your database need not be the administrator for your operating
system or your software.

00325 21062011

User Accounts
Use theDatabase > Administration > User Accounts command to define user profiles
and user groups for the current database.

Prerequisites for setting up of new users or user groups
You can set up user profiles and user groups in the database. Tomake this possible,
both of the following prerequisitesmust be fulfilled.

l Youmust have administrator rights for the database. If it was you who set up the
database, you will automatically have administrator rights.

l All of the users who you want to add to the databasemust have already been
registered with the DBMS (DatabaseManagement System, e.g., Microsoft SQL-
Server 2017 Express). This is a task for the DBMS administrator.
Should you be the DBMS-Administrator yourself, you can set up a new database
user in the DBMS via your software. If you have installed theMicrosoft SQL server
together with your software, then you'll automatically be the DBMS administrator.

Which users and user groups does a new database have?
By default, a newly set up database will always have at least one user, namely the
person who set it up. This user will have Administrator rights. By default, theEveryone
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user group will also be set up. This user group can't be deleted or manually edited. The
Everyone user group will be automatically updated when new users are added or
users are deleted. This procedure will ensure that a user group that incorporates all of
the database's users always exists.

5632

Setting up a new database user

Let's assume that your company has employed a new employee who is to have
access to the database. Before this person can open the database, the database
administrator must register the new employee in the database.

1. Use theDatabase > Administration > User Accounts command.
l In a newly set up database, there will always be at least one user, namely the
person who set it up. Additionally, theEveryone user group will always be set
up.

l In theUser Accounts dialog box. all of the existing users and user groupswill
be listed.

Adding users
2. Click theAddUser button.

l TheAddUser dialog box opens.

3. Click theBrowse button.
l TheSelect Database Server User dialog box appears. Here, all of the users
who are registered in the DBMS are listed. Should you be the DBMS
administrator, you can also register a new user in the DBMS there. To do this,
click theNew button.

l Should the user you want not be listed there, and you are not the DBMS
administrator, apply to the DBMS administrator.

l If you know which users are registered with the DBMS (e.g., because the
DBMS administrator has given you a list), enter the user's name in theUser
name field, then click theNext > button.
Then continue with the "Assigning user properties" step.

4. In theSelect Database Server User dialog box, select the required user, then click
theOK button.
l Youwill then see theAddUser dialog box oncemore.

5. If you want to, enter a description of the new user in theAddUser dialog box, then
click theNext > button.
This description appears in theUser Accounts dialog box, and can help you to
keep track of all of the users.
l TheUser Properties dialog boxwill appear. In it, you will see that the new user
has been automatically assigned to theEveryone user group.
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Assigning user properties
6. Should you want to, assign the user to additional user groups, then click theNext

> button.
l The next dialog box shows the possible roles the new user can be assigned. A
user has to be assigned at least one role. This determineswhich rights he has
to view certain database records.

7. Select the role the user is to be assigned. You can also assign a user several
roles.
l You can find a description of the possible roles here.

8. If you assign the user more than one role, select thePrompt for role selection at
login check box. Only in this case will the user be asked which role he is going to
use when he logs on to the database.
If this check box hasn't been selected, the user can't choose his role, but always
starts with the role that has been defined as the default role. Only the
administrator can assign this user another default role.

9. Click the Finish button.
l TheUser Accounts dialog box appears again. The new user is now shown in
the user list.

10. If required, addmore users to the database, or close the dialog boxwithOK.

Informing the user
11. Then inform the user.

l Inform the newly added user that he now has the right to open this database.

l Send him a link to the DBC file.

l Should you have newly set up the user in the DBMS, inform himwhich user
name and which password (including the case sensitivity used) he is to use
when he logs on to the database (when it's a database with SQL
authentication).
Whether the user will be able to change this password later on depends on the
options offered by the DBMS. In certain cases, passwords can only be
changed by the DBMS administrator.

Setting up a new database user in the database and the DBMS
simultaneously

If you are yourself the DBMS administrator, and have logged on to the database with
the administrator password, you can set up a new database user in the DBMS via your
software.

1. Use theDatabase > Administration > User Accounts command.
2. Click theAddUser button.
3. Click theBrowse button.

l TheSelect Database Server User dialog box opens. The required user does
not appear in the List of Users field.
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4. Click theNew button.
l TheAddNew Database Server User dialog box opens.

5. Enter the user name and assign a password for him. Select the authentication
SQLAuthentication.

6. Click theOK button.
l The newly set up user will then appear in the user list.

Changing the rights of an existing user in the DBMS

Prerequisite: Your are the DBMS administrator and are logged in to the currently
opened database with the administrator password.

You can edit the DBMS rights of an existing database user with your software. You
can permit a user to set up new databases and/or to define new users in the DBMS.
These rights apply for the DBMS and are not effected bywhich database is currently
opened or which of your software's work stations is being used.

1. Use theDatabase > Administration > User Accounts command.
l In theUser Accounts dialog box. all of the existing users and user groupswill
be listed.

Selecting a user
2. Select the user whose rights you want to change in the DBMS.
3. Click theProperties button.

l The <Name of user> Properties dialog box opens.

Changing user rights on the database server
4. In the <Name of user> Properties dialog box, activate theGeneral tab.
5. Click theServer button.

l TheAddNew Database Server User dialog box opens.

6. Change the current user rights in the DBMS. To do this, select or clear theAllow
user to create new users and/or theAllow user to create new databases check
box.

7. Close all open dialog boxeswithOK.

Setting up and editing a user group in a database

Setting up a new user group in a database
1. Use theDatabase > Administration > User Accounts command.

l TheUser Accounts dialog box opens.

2. Click theAddGroup button.
l TheNew User Group dialog box opens.

3. On theGeneral tab, enter the name of the user group and, if required, a
description.
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4. Go to theMembers tab. Since the new user group doesn't yet have anymembers,
click theAdd button.

5. In theAddUser dialog box, select a user who is to belong to the new user group,
then click theAdd button.
l The user you've added will appear on theMembers tab.

6. If required, click theAdd button again, then select another user who is to belong to
the new user group in theAddUser dialog box.

Note: Since you are the database administrator, we recommend that you also add
yourself to all of the user groups you set up. Only in this way can you be certain that
you'll always be shown all of the records that the database contains.

7. Click theOK button to finalize the definition of the new user group, and to close the
User Accounts dialog box.

Changing the members of a user group at a later point in time
1. Use theDatabase > Administration > User Accounts command.
2. Select the user group you want to change, then click theProperties button.
3. Switch to theGroupMembership tab andmake the required changes there.

00326
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